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Important Notice  
 
Welcome to Autodesk.         
This document is supplied as part of an Autodesk Training Course. It is not intended to be distance-learning material: rather as an aid for Tutors when presenting material to course delegates and as a subsequent aid memoir to those delegates.    
Autodesk does not accept responsibility for any personal belongings / valuables whilst on the premises. Delegates are advised to keep their belongings with them at all times.    
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The software described in this document is furnished under a license agreement and may be used only in accordance with the terms of this license.    
Copyright 2016 – Autodesk.  
All rights reserved. 
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PowerInspect CNC enables you to perform rapid inspections of parts and tools by comparing manufactured items with their CAD models. It includes a full geometric package, which can be used to inspect parts with or without a CAD model.  
You can also create inspection sequences offline and simulate them within PowerInspect CNC before running them on the measuring device. 

Choosing what to inspect 
PowerInspect CNC's Sequence Tree specifies the features to be inspected and the order of inspection. You can add features to the inspection sequence by picking them from a CAD model, or by selecting them from the Item toolbar. 
What can you measure? 
You can measure the following types of feature in CNC mode: 
 Surfaces 
 Edges 
 Sections 
 Geometry, including 2D features, such as circles, and 3D features, such as cones 
In addition, you can measure Point clouds in manual mode. 
Aligning the part 
PowerInspect CNC provides the following methods of aligning the part to the CAD model: 
 Free Form alignment — Aligns the part to the CAD using measured dynamic points. This enables you to measure parts that have no clearly definable features. 
 Geometric PLP alignment — Creates an alignment using geometric features that have known nominal coordinates. 
 Three Spheres alignment — Creates a PLP alignment by probing tooling balls that have nominal coordinates. 
 From File alignment — Loads a previously saved alignment from file. You can use this option when inspecting multiple examples of a part. When you use this alignment, each example must be identically positioned on the inspection table. 
 Best Fit From Points — Aligns the part using three or more points that have known nominal coordinates. 
 Reference Point System (RPS) alignment — Creates an alignment using the XYZ values of up to one hundred features. 

1. Introduction 
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 From Point Cloud alignment — Aligns the part using a point cloud. The point cloud must include data from more than one surface. 
 Point Cloud Picked-Points alignment — Creates an alignment using selected points in a point cloud. 
 PLP (Plane, Line, Point) alignment — Creates a geometric alignment using a datum created from a Plane, a Line and a Point item. 
 User Defined alignment — Aligns the part by specifying the relationship between the reference systems of the Machine Datum and the PCS (CAD Datum). 
 Offset alignment — Creates an alignment by measuring a specified position on the part. 
When you have measured one or more inspection groups, you can use Best Fit items to optimize the alignment of the part with the CAD model. PowerInspect CNC compares the points of selected groups to the nominals and adjusts the alignment using one of five fitting methods. 
Inspecting the part 
You can perform inspections manually or by creating probe paths and running inspection sequences under computer control. 
As you inspect the part, PowerInspect CNC displays inspection points and features in the CAD view. Customizable colour-coding enables you to quickly see which items are in tolerance, above tolerance, and below tolerance, and the Info tab provides full details of the currently selected item in the inspection sequence. 
If you want to inspect several examples of the same part using the same inspection sequence, you can use Measures to save all the results in one document. 
Creating reports 
PowerInspect CNC automatically produces a customizable HTML report on the Report tab. You can choose which measurements to include, or you can show all measurements for all features in your inspection. 
You can also generate printable reports using a PDF generator or Microsoft Excel. 
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Opening PowerInspect CNC 
To open PowerInspect CNC, double-click the desktop icon. 

 
The screen should look as follows: 

 
The work environment remains empty until you start a new session. When a new session is started, further options become available in the Menu bar, and a graphics window, Sequence Tree and context-sensitive toolbar are generated. 

Creating a new session 
A new session can be started from the File menu or from the Main toolbar. 

 New Session  creates a new inspection document without loading a CAD 
model. 

 New Session Wizard  allows you to choose whether you want to open one or more CAD models. When you start a new session using the New Session Wizard, you are guided through the process step by step. 
 If a PowerInspect CNC session (*.pwi) already exists, you can select File > Open. 

Alternatively, click Open  on the Main toolbar. 
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New Session Wizard 
1 Click the New Session Wizard  button to open the New Inspection Session 

dialog. 

 
This dialog contains three options for creating an inspection session: 
 Measurement without CAD creates an inspection session without opening a CAD model. This is the same as selecting New Session from the Main toolbar. 
 Measurement with a single CAD Part creates an inspection session using one 

CAD model. 
 Measurement with multiple CAD Parts creates an inspection session using multiple CAD models.  

2 Select Measurement with a single CAD part and click Next to display the second page of the wizard. 

 
Use this dialog to browse to the CAD file that you want to open. You can also specify the Units you want to work in, and specify offsets for surface and edge points. 
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3 Click New to browse to the CAD file for the part you want to inspect. 
4 In the Open dialog, select DemoBlock2008(CMM+Arm).dgk and click Open. 

 After a CAD file has been selected, it can be transformed. Click Details to display the CAD Details dialog and select Transformation Matrix (For further details, see Chapter 2). 
5 Click Next to display the next page of the wizard, Variables. 

The Variables dialog allows you to choose the template in which you want to report your measurements. Click Browse to navigate to the template file you want to use. 

 
PowerInspect CNC has the ability to create reports in two formats: 
 HTML format reports are created directly inside the PowerInspect *.pwi file, and are accessible through the Report tab below the Graphics window. 
 Microsoft Excel reports allow backwards compatibility for older versions. 

Entries can be edited by clicking on the required field and editing the contents. 
6 Click Finish to complete the process and begin the session. 
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The Graphics Window 
When a session is open, a number menus and toolbars are displayed, as shown below. 

 This screen layout is for CNC licence. 

 
 Sequence Tree 
 CAD/View toolbars 
 Graphics window 
 View tabs 
 Probe status bar 

The Graphics window includes the following tabs: 
 CAD View displays the CAD model and all inspected results.  
 Info displays information about the selected item in the Sequence Trss. 
 Report displays the report in HTML format. 
 Dynamic Points lists the points used in an inspection. 
 Section displays the section each time you create a Section group. This tab is only available when you create a Section group. 



PowerInspect CNC 2017 1. Introduction 

Copyright © Autodesk PowerInspect CNC 2017 1.7 

Menu bar 
The Menu bar is located at the top of the main window. 

 
Click a menu to open it. If a menu item is unavailable, it does not apply to the 
document. A small arrow  next to a menu item indicates that there are more options available. Move the cursor over the item to display these options. 

 
Click outside a menu option to cancel a command and close the menu. 

Main toolbar 
The Main toolbar is displayed at the top of the graphics window under the Menu bar. The buttons allow easy access to the most frequently used PowerInspect CNC menu 
items. 

 

Item toolbar 
The Item toolbar is used for the creation of alignments, geometric groups, inspection groups, and datums. 

 
The toolbar changes according to the function chosen. 
Click on an icon with a small arrow next to it to open that item's submenu. For 

example, clicking the Miscellaneous  button displays the following toolbar: 

 



1. Introduction PowerInspect CNC 2017 

1.8 PowerInspect CNC 2017 Copyright © Autodesk   

CAD View toolbar 
The CAD View toolbar contains options to orientate and shade the CAD model.  

 

View Options toolbar 
The View Options toolbar enables you to display measurement data in the graphics 
window, and to control the information that is displayed. 

 

Mouse Context toolbar 
The Mouse Context toolbar enables you to choose the function of the cursor. 

 

Toolbar visibility 
Right-click in and empty area of the toolbar or menu bar to toggle the visibility of all toolbars. 
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Views and View Manipulation 
After the new session has been created, you can view the CAD model in order to gain some visual information about the part. To do this, the various views and their manipulation need to be understood. 
Before running through the views and view manipulation, the use of the mouse functions will be established. 

Mouse buttons 
Each of the three mouse buttons performs a different dynamic operation. 

Left mouse button: Picking and selecting 

 
This button is used for selecting items from the menus, options within dialogs, and items in the graphics area. 
It is also responsible for view manipulation depending on the setting used in the 

Set Mouse Button 1 View Mode  button. 

Middle mouse button: Dynamics 

 
 Zooming in and out: Hold down the Ctrl key and the middle mouse button. 

Move the mouse up and down to zoom in and out. Alternatively, rotate the scroll wheel, if available. 
 Pan around the model: Hold down the Shift key and the middle mouse 

button. Move the mouse in the required direction. 
 Zoom box: Hold down the Ctrl and Shift keys, and drag a box around the 

area that you want to zoom into using the middle mouse button. 
 Rotate mode: Hold down the middle mouse button and move the mouse to rotate the view. 
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Right mouse button: Dynamics, Special Menus and 
PowerInspect CNC Sequence Tree Options 

 
 Zooming in and out: Hold down the Ctrl key and the right mouse button. Move the mouse up and down to zoom in and out. 
 Pan around the model: Hold down the Shift key and the right mouse button. Move the mouse in the required direction. 
 Zoom Box: Hold down the Alt key and the right mouse button. Drag a box 

around the area that you want to zoom into. 
 Rotate mode: Hold down the Ctrl and Shift keys, and use the right mouse button to rotate the view. 
When the right mouse button is pressed on its own, a popup menu is displayed based on the item that the mouse is over, such as the Sequence Tree, or the toolbar menus. 

View menu 
The View menu is accessed from the Menu bar and contains the Resize to Fit option, and a number of View submenus. Each of these submenus corresponds to a different group of views. 

 
 From — These options allow you to alter the viewing angle of the part shown in 

the CAD view. 
 ISO — These options allow you to alter the CAD view layout. 
 Custom View — These options allow you to save the current CAD view for future 

use and to reload previously saved views. 
 Rotation Anchor — These options allow you to specify how the model in the CAD 

view is rotated. 
 Machine – These options allow you to toggle the Machine/Probe/Tool visibility within the graphics window. It also details the keyboard shortcuts. 



PowerInspect CNC 2017 1. Introduction 

Copyright © Autodesk PowerInspect CNC 2017 1.11 

 Probe Paths — These options are only applicable for the CNC version of the 
software. They allow you to control which probe paths can be seen in the CAD view. 

 Grid Mode — These options allow you to specify the coordinate system in which 
the grid is displayed. 

 Level — These options allow you to group surfaces into levels and to control 
which levels are displayed in the CAD view. 

 Toolbars — Use these options to display or hide the toolbars and Status bar. 
The View flyout shares these functions. 

View flyout 
Open the View flyout by clicking the arrow below the Select View button on the CAD 
View toolbar. This flyout contains a series of buttons that correspond to the same icons in the view menu. 

 
 

The 1, 2, 3, and 4 buttons are used to select the Custom Views, which can be saved 
using the corresponding Save  button. Rotations can also be triggered using the Arrow keys on the keyboard, by dynamically moving the cursor using the Mouse 

Functions, or by using the Rotations  flyout. The rotation axis is selected from 
the flyout and the view then rotated incrementally by clicking on the button.  

Window menu 
If more than one session is open, you can view all sessions in a single screen, using the Window menu. The sessions can then be arranged according to your preference. 
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The CAD View 
The CAD View is where all the inspection and geometric information is viewed. CAD models can be seen either with no shading, transparent shading, or solid shading, combined with or without wireframe. 

Click the Shading Mode For Model  button to open the Shading Mode 
 flyout and choose the shading you want to apply to the CAD model. Alternatively, use the shortcut keys to toggle the wireframe and shading.  

 w — toggle wireframe on/off 
 s — toggle shading on/off 

 
Solid Shading 

 
Transparent Shading 

 
Wireframe Shading 
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Surface normal direction 
PowerInspect CNC has a function which allows you to determine the surface normal direction. 

Using the Highlight back-facing surfaces  button in combination with the shading, will show all reversed surfaces as bright red. This is useful for determining the direction needed for surface offsets. 
To reverse a surface: 

1 Click Highlight back-facing surfaces .  

2 Click Surface Selector . 
3 Click a surface to select it. The edges of the selected surface are highlighted yellow. 

 
4 Right-click in the CAD View and select Inverse Surface from the menu. 

 
The selected surface changes colour to red to demonstrate that it is reversed. 
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The Report Template 
PowerInspect CNC enables you to select from a number of templates to control the form in which your measurement data is output. For HTML format, the report is integrated into the PowerInspect CNC work environment, and can be accessed at any time using the Report tab. Reports can be customised to suit your customers’ needs. 
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The Information Tab 
The Info tab allows you to view specific items for positional data, tolerances, 
deviations and errors. This can be displayed by selecting the item to be investigated from the Sequence Tree, and then selecting the Info tab. The following example shows the information for a Probed Circle: 
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PowerInspect CNC Help 
PowerInspect CNC comes with an online help which can be accessed from the Help menu. When faced with a problem, it is best practice to make the Help menu your first port of call. 
To access the online help, select Contents from the Help menu. 

 
The most effective way to use the Reference Help is to use the Search tab to search for help topics, but you can also browse the Contents or Index.  

 
To target your search more effectively, enclose the search terms within quotation marks. For example, to search for help on exporting point clouds, enter "Export point cloud" in the search box so that only topics containing this exact phrase are displayed. 
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Customising PowerInspect CNC 
Select Tools > Options to display the Options dialog and specify settings and defaults 
for PowerInspect CNC. 

 
Use the Options dialog to specify settings including, the colour of entities, the size of points, confetti or edge points and toggle displayed items such as the CAD Datum. 
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The Machine tab enables you to configure the tools you will use for an inspection, to model the measuring device displayed in the CAD view, and to calibrate the probe head and probe assembly prior to an inspection. It contains a Probe view that displays the status of your probes and probe assemblies, and nine areas that cover the different aspects of machine management.  
To view and configure the measuring device for an inspection: 
1 Select File > New Session. 
2 At the top of the Sequence Tree, select the Machine tab. 

 
3 To display the details of an area, click its title. To close an area, click the title again.  

02. Machine Tab 
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Setting the calibration details 
The Calibration area of the Machine tab displays the diameter and name of the 
sphere used to calculate the position of the probe and the effective diameter of the stylus.  

 
Use the area to customize the calibration process, and to view and manage calibrations. Click: 
 Change to move the calibration sphere. The Calibration Sphere Repositioning 

Wizard is displayed.  
 Calibration settings to change the number of calibration points, the safe distances settings, traceability, or manual calibration. The Calibration Settings dialog is displayed. 

 The Calibration Settings button is not available when Simple calibration 
mode is selected in the Calibration page of the Options dialog. 

 Calibration Details to view and export the details of calibrations for traceability 
purposes.  

Specifying the machine 
The Machine area enables you to select the measuring device displayed in the CAD view so that on-screen simulations are shown realistically.  

 
To specify the machine model: 

1 Click Change Model.  
 Alternatively, you can select the Tools > Simulator > Change Machine Model menu option.  

2 In the Open dialog, navigate to the \CMM folder of your PowerInspect CNC 
installation, and select the model you want to display. For this example, select 
No_model_head-head.mtd.  

 If your machine is not listed, contact your reseller to request the model you need. 
3 Click Open to display the model in the CAD View tab. 
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Selecting the probe head 
The Probe head area enables you to select and calibrate the head to be used for the 
inspection. By default, PowerInspect CNC includes the complete range of Renishaw CNC probe heads; contact your reseller to add heads from other manufacturers.  

 
To select the probe head for the inspection: 

1 In the drop-down list, select Renishaw PH10T. The head is displayed in the CAD 
View tab. 

2 If the head in the CAD view is not aligned with the head of the measuring device, use the RX, RY, and RZ boxes to rotate the on-screen head to the same orientation as the device head. Click Apply to save your changes. 

Creating the probe tool 
The Probe Tool area enables you to specify and select probe assemblies for the inspection. The probe assembly is built from the Renishaw catalogue; the available options are determined by the selection you make in the Probe Head area. 

 
To create a probe tool assembly: 

1 Click New in the Probe tool area. The Probe Tool Assembly dialog is displayed.  
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2 In the Probe tool assembly box, enter TP20_MED_20x2 as the name of the 

assembly.  
3 In the Available probe tool parts drop-down list, select Probe bodies. 
4 In the list of bodies, select TP20 and click Insert Part.  

 If the body you want to use is not listed, click Create Custom Part to specify the details of the body. 
The part is added to the Probe tool assembly list, and the list’s insertion line moves to show where the next part will be inserted. In addition, the Available 
probe tool parts lists the modules available for the body you selected.  

5 In the list of modules, select TP20_MED, and click Insert Part. 
The part is added to the Probe tool assembly list, the list’s insertion line moves is updated and the Available probe tool parts lists the available styli.  

6 In the list of styli, select M2_20x2_SS and click Insert Part.  
7 Click Save to save the changes and close the dialog.  

The assembly is displayed in the Probe tool area. It is also selected as the current probe tool in the Probe view at the top of the Machine tab, and displayed in the CAD view. 
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If you need to update the tool, click Edit.  

 To copy a probe assembly, click Clone. 
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Calibrating the probe 
Before you can inspect a part, you must calibrate the probe head and the assemblies you want to use. This enables PowerInspect CNC to calculate the effective stylus diameter and to apply compensation to measurements.  
To calibrate the probe: 

1 In the Machine toolbar, click  to connect the document to the measuring 
device.  

2 In the Calibration area, click Calibration Settings. The Calibration Settings dialog is 
displayed. 

3 To automate the calibration process, deselect the Perform manual calibration check box, and click OK to close the dialog. 
4 In the Probe head area, click Calibrate. The Probe Head Calibration Wizard is displayed. 
5 Read the information in the first dialog, and click Next. The Limits dialog is 

displayed. 
6 Leave the limit values unchanged, and click Next. The Calibration Sphere dialog is 

displayed.  
7 Enter the calibration sphere parameters: 

a In the Enter the diameter of the calibration sphere box, type 20. 
b In the Enter the name of the calibration sphere box, type Sphere20. 
c Leave the direction settings unchanged, and click Next. The Probe Selection 

dialog is displayed. 
8 Select the probe tool you created earlier, and click Next. The Probe Head Main Orientation dialog is displayed.  
9 Leave the orientation unchanged, and click Next. The Probe Head Angles dialog is displayed. 
10 Select the (A0 : B0) (A90 : B0) (A90 : B90) option to specify the probe head angles you want to calibrate, and click Next. The first Calibration dialog is displayed. 
11 In the dialog: 

a Manually probe the point on the calibration sphere normal to the probe assembly.  
b Position the probe so it can rotate without touching the sphere, and click Set 

A=90, B=0. The probe rotates to the new orientation. 
c Probe the sphere at the same position you used in step a.  
d Click Next. The Assisted Calibration dialog is displayed.  

12 Position the probe so it can rotate without touching the sphere, and click Next.  
13 In the warning message, click Yes. PowerInspect probes the sphere to complete the calibration. When it has finished, the results are displayed in the dialog.  
14 Click Finish to close the wizard. The last calibration date; the effective or nominal diameter of the stylus and its sphericity are displayed below the Probe view, for example: 
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In addition, icons indicate whether the probe and probe position are calibrated , calibrated but outside form tolerance , or uncalibrated . 

 The  icon is only displayed when you specify a form tolerance for the calibration in the Calibration Settings dialog.  
You can now probe the part or create more head positions. 

 To check the results of all the calibrations you have made for the document, open the Calibration area, and click Calibration Details.  

Adding probe positions 
When you have selected an indexable head, such as a PH10, you can specify multiple probe positions so that the probe is at the optimum orientation for measuring the different features on the part. The Probe head angles area enables you to specify any probe orientations not included in the original calibration.  

 
To specify a position for the inspection: 
1 In the A box, enter an angle of 45 degrees. 
2 In the B box, enter an angle of 0 degrees.  
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3 Click Create to add the position to the Probe view list, or click Create & Apply to 
add the position and select it.  
 You can also create new positions by selecting ToolCollection in the Probe 

view, and then clicking  
To calibrate the new position: 
1 Select the position  in the Probe view. 
2 Click the Calibrate Selected Item button. The Probe Calibration Wizard is displayed. 
3 Position the probe so it can rotate without touching the sphere, and click Next. PowerInspect probes the sphere and reports the results. 
4 Click Finish. The results of the calibration are displayed in the Probe view. 

Setting target points 
The Target Point area enables you to find the current position of the probe, or to 
move the probe to a specified position.  

 
 If the document is not connected to the measuring device, only the probe in the CAD view is moved. 

To set a target point: 
1 Choose an entry in the list to specify the coordinate system you want to use. Select: 

 CMM Probe Tip Coordinates to specify the target coordinates relative to the position of the probe tip. 
 CAD Coordinates to specify the target coordinates relative to the PCS (CAD Datum). 

 The list is not displayed when <no measure> is selected in the Active Measure list. 
2 To display the current position of the probe, click . The position is displayed in the X, Y, and Z boxes. 
3 Choose the method with which you want to specify the position of the target point: 

 Select the mode  button to specify the position relative to the origin of the coordinate system.  
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 Deselect the mode  button to specify the position relative to the probe's current position.  
4 Enter the point's coordinates in the X, Y, and Z boxes. 

5 Click  to move the probe to the target point; click  to halt the probe movement. 

Controlling the simulation speed 
When you simulate an inspection in the Run tab, PowerInspect CNC runs the simulation in real time, by default. Use the Simulation Parameters area to change 
that speed if you want to slow down the simulation to check the details, or speed up the simulation to just make a final check.  

 
To specify the scaling factors for the simulator: 
1 If you want to synchronize the-speed multipliers, select the Use the same factor check box. 
2 Move the Simulation move speed multiplier slider to change the speed at which 

GoTo (or rapid) moves are performed. The multiplier is displayed at the right of the slider. 
3 Move the Simulation measure speed multiplier slider to change the speed at which 

measurement (or touch) moves are performed. The multiplier is displayed at the right of the slider. 

Viewing the machine parameters 
The Parameters area enables you to view and change the current probing parameters of the measuring device when the document is connected to it.  

 
To view or change the machine parameters: 
1 Connect to the measuring device. 
2 In the Joystick retract box, enter the distance that the probe automatically 

retracts when you use the joystick to take a touch point. 
3 Click  to display the CMM Parameters. The CMM Parameters dialog is displayed.  
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4 Select the different tabs to view the parameters; position and hold the mouse cursor over a box for more information on a setting.  
5 When you are finished, click OK to close the dialog. 

 To maintain consistency, you are recommended to use Probe and Parameters items to specify the machine settings for each stage of an inspection.  

Importing and exporting probes 
The probe head and probe tool settings on the Machine tab are saved with the PowerInspect document (.pwi file), so the next time the file is opened the details are remembered. You can export these settings to a file, and then import them into other inspection documents to avoid the need to set up the same settings for each new session. 
To export the current settings to a file: 
1 Click Export on the Machine tab to display the Save As dialog. 
2 Enter a name for the settings file in the File name box. The settings are saved in a .prd file. 
3 Click Save on the Save As dialog to return to the Machine tab. 
To import settings from a file: 
1 If you are importing the probe database from a measuring device, use the Export 

button to create a back up of the current settings.  
2 Click Import on the Machine tab to display the Open dialog. If a warning message is displayed, click Yes to replace the current settings; click No to continue to use 

the current settings.  
3 Select the .prd file that contains the settings you want to use. 
4 Click Open. The settings in the .prd file are applied to the document and displayed in the Machine tab. 
If the current Machine model and Probe assembly settings are the typical setup used for your inspections, click Export as default. When you next create a document, PowerInspect will automatically load your current settings so you don’t need to repeat the configuration process each time you start a new inspection. 
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The manipulation of CAD data within PowerInspect CNC is very important. Using the 
CAD File Manager, you can add or remove CAD files, transform CAD data in relation to datums and indicate levels to be included in the inspection. 

Coordinate Systems 
When you create an inspection session, PowerInspect CNC automatically creates two coordinate systems:  
 The Machine Datum is the X 0, Y 0, and Z 0 of the 3D coordinate measurement machine. 
 The PCS Datum (Part Coordinate System Datum), is the X 0, Y 0, and Z 0 of the CAD model. If the PCS Datum is in the wrong location, you can transform it using translations and rotations. 
When the part is aligned with the CAD model, PowerInspect CNC automatically converts the movements from the Machine Datum coordinate system to the PCS Datum coordinate system. 
By default, these datums are not displayed in the CAD view. To display them, click 
the light bulb  icon next to their entries in the Sequence Tree. The icon changes to 

 to indicate the datums are displayed. In this example, the PCS Datum is shown at the corner of the part; the Machine Datum is shown above and left of the PCS Datum. 

 
In addition to the datums, a graphical representation of the coordinate system of the active alignment (the PCS Datum, by default) is displayed at bottom left of the CAD view. It allows you to identify the axes of the active alignment when the active alignment is not visible on screen. 

 

3. CAD Management 
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CAD File Manager 
To display the CAD File Manager, select the CAD tab. 

 
When you select the tab, the window displays the Parts folder and the User Levels 
area. Click the  icon to open folder and display the sub-items. 

 
The coloured box indicates the colour with which each level is displayed in the CAD 
View. Change the colour by left-clicking the box, and assigning a new colour from 
the palette. 
The light bulbs indicate whether the level is displayed or not  in the CAD View, 
and the check box  includes or excludes the level from the CAD Context. These can all be switched on or off by left-clicking on them. 
When the CAD File Manager is opened, a toolbar is displayed at the top of the tab 
with a number of functions that can be used to manipulate the CAD data. 

 
This toolbar enables you to: 
 add or remove CAD files. 
 reset the user levels. 
 edit the CAD details. 
 show or hide CAD files and the detailed view. 
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Transformations 
Click the CAD Details  button to open the CAD Details dialog. This dialog 
enables you to locate CAD files and apply transformations to them. 
Transformations are used to orientate parts within the CAD View. 
To transform any CAD data, you must first specify the part by using the Browse button in the CAD Details dialog. 

 
 You cannot use PowerInspect CNC to edit the CAD model. You can create, hide and edit levels, but they cannot be saved to the CAD model and they are only visible within PowerInspect CNC. 

When the part is specified, click Transformation Matrix to open the Transformation 
Matrix dialog. 

 
Use this dialog to specify any transformation (Rotation, Translation, Mirror and 
Scale), by clicking on the appropriate button and entering the desired values. 
For example, clicking Rotation opens the Rotation dialog. In this dialog, you can specify the rotational axis (for example, the X axis) and the angle by which the part is rotated (for example, 90 degrees). 
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Click OK to close the Rotation dialog. The Transformation Matrix dialog is updated with the new value. 

 
Click Load to read and load workplanes from multiple CAD formats (supported by 
Autodesk Exchange). 
When a CAD model is selected, the Select Workplane dialog lists all the workplanes 
associated to the model. 

 
When you select a workplane, its transformations are displayed in the 
Transformation Matrix dialog. 

 
Click OK to apply the transformations to the model relative to the datum. 
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These transformations can be saved, deleted, edited and tested within this dialog. To edit or delete a transformation, left-click its entry in the Transformation Matrix dialog. 

Summary and Detailed CAD View 
Click the Summary/Detailed View  button on the CAD File Manager toolbar to 
expand the CAD information area and display more information about the part files. 

 
The information displayed includes any transformations, the levels, part locations and the number of entities that make up the part. 
The extent values indicate the dimensions of the part in relation to the datum origin. 

Click Summary/Detailed View  again to return to the data summary. 

 
When the Levels section is expanded, the sub-levels reveal the individual surfaces.  
As before, the light bulbs hide  or show  the individual level or surface. The 
check box  includes or excludes the level from the CAD context. These icons can be switched ON or OFF by left clicking on them. 
The levels can also be managed from the Menu bar. 
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Select Measures > CAD Levels for Inspection from the Menu bar to display the levels 
section. 

 

CAD Menu Options 
As well as the CAD File Manager, CAD edits can be made using some of the options on the Menu bar. 
The Measures menu contains two options that are relevant to the CAD management.  

 
Select Parameters to open the Measure Parameters dialog. This dialog contains a series of tabs that relate to different areas of PowerInspect CNC. 
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Level Edits 
CAD data within PowerInspect CNC can be transferred to other or new levels. 

Click the Surface Selector  button in the Mouse Context toolbar to specify which surfaces you want to move, and to which level. 
To create a new level: 

1 Click the Surface Selector  button on the Mouse Context toolbar. 
2 Use the left mouse button to box-select the surfaces that you want to add to a level. 
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When you release the mouse button, the selected surfaces are highlighted. 

 
 Alternatively, you can select individual surfaces by left-clicking the model. 

3 Right-click anywhere on the highlighted selection and select Group Surfaces from 
the local menu. 

 
The Level Manager dialog is displayed. 

 
4 To add the selected surfaces to an existing level, select the level in the Available 

levels list, and select OK. 
To add the selected surfaces to a new level, enter a Name for the level, and click 
OK. The level appears in the User levels area of the CAD File Manager. 
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This technique can be useful if there is a large quantity of data in a view. Each layer has an associated colour, which is used when colour shading the model. To change the shading colour of a level, left-click the small coloured box to the left of the level’s name, and select a new colour from the palette. 
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Within PowerInspect CNC it is vital that the probe is correctly calibrated as these will affect the results. Using the various wizards you are lead through the steps taken in order to calibrate your CNC CMM easily and effortlessly.  
The process of calibration allows physical properties of the probe and the stylus to be calculated. Such values include the contact radius and effective length of the probe 

Probe Head Calibration 
The first part of the calibration process in PowerInspect CNC is to calibrate the probe head attached to the CNC CMM. 

1 Select > File –> New Session. 
 

2 Build the probe from the database of components ensuring that all parts specified match the physical probe used in the inspection. In this example we will be using the PH10T head with a TP20_2mmx20 probe setup 
 To refresh this process read chapter ‘Machine tab’. 

 

 
3 Select the PH10T in the machine tab probe view and click on the ‘Calibrate selected item’ icon 

 

4. Calibration 
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This initiates the probe head calibration wizard, which leads the user through the calibration in a step by step process. 
 It is important that the user is compitant in using the software and opertating the CNC CMM as this could potentially damage equiptment 

4 If the user accepts the warning message, press next to move on to the next dialog method 
5 Enter the appropriate limits of the CNC in use, for this example the default limits predefined in PowerInspect CNC 

 
6 Once defined select the diameter of the calibration sphere, in this instance the sphere is 20mm 

 
 

7 Once defined select ‘Next’ and assign the appropriate probe build - This will be TP20_2mmx20 
 
8 Follow the steps through until the following window in displayed and then follow the instructions step by step to calibrate the probe head. To move the probe into the required position, use the CNC CMM joystick.  
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The calibrated measuring speed is the feedrate, at which the probe is calibrated, it is very important that any measurements using the probe are taken at the calibrated speed. It is important as this ensures that the deflection of the stylus remains constant and therefore the results are consistant. 
 

9 Once complete click finish to end the head calibration 
 
Calibration is important as PowerInspect CNC will not run a program as a safety precaution because there is a high risk in damaging the probe head or the stylus due to incorrect movements. 
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Stylus Calibration 
The second stage of the calibration process in PowerInspect CNC is to calibrate the the stylus with the probe head angles. 
There are two methods of calibrating the probe head angles in PowerInspect CNC. The first one is to open the single probe head angle calibration wizard and then second is to calibrate a batch of probe head angles for time saving purposes. 

1 In the same session, input a series of different probe head angles by selecting the ‘Add new positions’ icon.  

 
2 Use the sliders to select the angles of rotation to set a number of probe orientations 

 
3 These are then saved in the probe view but remain uncalibrated 
When creating a sequence of inspection steps, a number of features of the part being measured may require different probe head angles. These will automatically be added to the list without the need to perform step 2. 

4 To calibrate a single probe angle, select the probe head angle in question and click on the ‘Calibrate selected item’ icon. 

 
5 Follow the onscreen instructions to calibrate the probe angle. 
The second method is to calibrate a number of angles in a single process. To perform this method, simply repeat steps 1-3 and select ‘Calibrate uncalibrated positions’ icon and follow the on screen instructions 
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Alignments enable PowerInspect CNC to match the positions and orientations of the CAD model to the part. The type of alignment selected is dictated by the component's shape and which features can be used be used to create it.  
Alignments are accessed by selecting Alignments in the Item toolbar. 

 
The most widely used alignments are described in this chapter.  

Geometric PLP Alignment  
The Geometric PLP Alignment  is based on the relationship of a physical Plane, 
Line and Point (PLP), and CAD Defined Coordinates, which define the part in the X, Y and Z axes. It is an accurate method of alignment because it works directly from CAD nominal values, and can be an easier method to understand. 

Generating a Geometric PLP Alignment 
For this example the DemoBlock2008 CAD file is going to be used. 

1 In the Main toolbar, click  to open the New Document Wizard. 
2 Select Measurement with a single CAD Part and click Next. 
3  Click New and open DemoBlock2008(CMM+Arm).ddz. 
4  Leave the Offset and Tolerance settings unchanged, and click Next. 
5 In the Variables dialog, browse for any HTML Report Template (Excel could be used, but for this example HTML is to be used). 
6  Click Finish. The new session is now ready for inspection. 

5. Alignments 
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Choosing the Geometric features 
Before the alignment can begin, a decision needs to be made on where the Plane, Line and Point are going to be aligned to, and what will determine these elements. 
The Plane 
With any alignment, the results are better if a greater area spread is used to define the aligning elements. In this example, the CMM bed (or table) will be used to define the plane, because the model has a flat base, and all the planes in the model are small. 
The Line 
Lines can be defined from square edges (probed lines), or from the connection or intersection of measured features. In this example, the line is to be defined in the X direction, using the centres of two measured circles on the part.  

 The line direction in a Geometric PLP Alignment must be axial. 
The Point 
Because the circles will have already been defined, the centre position of one of these circles will be used for the point position. 

 
The two circles chosen are indicated, and the plane will be the top flat face. The line will be between the centres of both circles, and the point will be taken from the centre of circle 1. 
Both circles and line will be projected onto the same probed plane. 

Defining the Geometric Items 
When you have chosen the features to use for the alignment, you must now define the geometric items to probe. 
1 In the Machine tab, create a 3 mm probe and select it in the Probe view. 

2 In the Mouse Context toolbar, select the Wireframe Checker  button.  
3 Right-click an empty area of the graphics window and select Surface from the 

menu. 
4 Select the top plane as shown, and double-click the surface to create probe points shown below. 
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5 In the Plane Inspect dialog, click  to add the item to the Sequence Tree. 

6 Select the Wireframe Checker  button.  
7 Right-click an empty area of the graphics window and select Wireframe from the menu. 
8 Move the cursor over the circle shown below. When the circumference is highlighted, left-click to select it. 

 
9 Select the Geometry Explorer tab, and select Plane 1 in the Linked to list. 

10 Click  to add the item to the Sequence Tree. 
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11 Move the cursor over the circle shown below. When the circumference is highlighted, left-click to select it. 

 

12 Click  to add the item to the Sequence Tree. 

13 In the Item toolbar, select Lines , and click . The Line: Two Points dialog is displayed. Ensure that the reference points are set as follows: 
 Reference Point 1 — Circle 1::Centre 
 Reference Point 2 — Circle 2::Centre 

 
14 Click OK to add the line item to the inspection sequence.  
15 Select the Run tab and simulate the inspection. 
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Creating a PLP alignment 
1 In the Sequence Tree, click  to close the group. 

2 From the Alignments  toolbar, select Geometric PLP . The Geometric 
PLP Alignment dialog is displayed. 

3 In the Plane area, select Plane1.  
4 In the Line are, select Line 1. 
5 In the Point area, select Circle 1::Centre. 

 
6 Click OK to save your changes and close the dialog. The alignment inspection sequence is now ready to be run. 
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RPS Alignment 
The Reference Point System (RPS) alignment is a technique developed by Volkswagen and has now become an industry standard for inspection. As an alignment technique, its method lies somewhere between a Free Form alignment and a Geometric alignment, combining the benefits of both, with the ability to accept geometric positional data and surface points. 

Generating an RPS Alignment  
Using the methods previously described in the course for starting a new session: 

1 In the Main toolbar, click  to open the New Document Wizard. 
2 Select Measurement with a single CAD Part and click Next. 
3  Click New and open DemoBlock2008(CMM+Arm).ddz. 
4  Leave the Offset and Tolerance settings unchanged, and click Next. 
5 In the Variables dialog, browse for any HTML Report Template (Excel could be used, but for this example HTML is to be used). 
6  Click Finish. 

Choosing the features 
As with other methods, you must specify which geometric features can be used to determine the alignment. In this example, the part is aligned using a series of probed circles. The centres of these circles are then used to determine the RPS alignment. The Geometry Explorer is used to create these circles. 
1 In the Machine tab, create a 3 mm probe and select it in the Probe view. 

2 In the Mouse Context toolbar, select the Wireframe Checker  button.  
3 Right-click an empty area of the graphics window and select Surface from the menu. 
4 Create the probed plane shown below. 

 
5 Right-click in the CAD View and select Wireframe from the menu.  
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6 Select the circle shown below. 

 
7 Select the Geometry Explorer tab, select Plane 1 in the Linked to list, and click 

. 
8 Create inspection items for Circle 2 and Circle 3, linking them all to Plane 1. 

 
The Sequence Tree displays the four items, a plane and three circles, which can also be seen in the CAD View.  

 
9 Select the Run tab and simulate the inspection. 
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Creating an RPS Alignment 
An RPS alignment will now be used to align the CAD model to the part. 

1 In the Sequence Tree, click  to close the group. 

2 From the Alignments  toolbar, select RPS Alignment . The RPS 
Alignment Definition dialog is displayed. 

 
3 Select Circle 1::Centre in the drop-down list to add it to the alignment. Click  to add further items to the alignment as shown.  

The Lock columns are used to specify the translation and rotation axes that each feature is used to constrain. The selections shown are just enough to create a 3-2-1 alignment, so the part is said to be perfectly constrained.  
If you add further locks to the alignment, the part is said to be over constrained. In this case, PowerInspect creates a best fit that minimizes the deviations between the part and the model for all the features.  

4 Click OK to save your changes and close the dialog. 
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Best Fit From Points Alignment 
The Best Fit from Points  alignment can be used to align the part from three or 
more points for which the CAD coordinates are known. PowerInspect uses these points as geometric items to carry out a best fit to align the CAD data. 
Before you use this alignment, you must create geometric items that provide at least three points. Points include centres of geometric items, such as the centre of a circle or sphere. You must also know the nominal position of the points: if you do not have this information, you can extract the coordinates using the Geometry 
Explorer tab.  

 A Best Fit alignment can produce the same results as a Three Spheres alignment if spheres are used to supply the three points. A Three Spheres alignment uses tooling balls; it is predominately used in the aerospace industry. 

Generating a Best Fit from Points Alignment 
1 In the Main toolbar, click  to open the New Document Wizard. 
2 Select Measurement with a single CAD Part and click Next. 
3  Click New and open DemoBlock2008(CMM+Arm).ddz. 
4  Leave the Offset and Tolerance settings unchanged, and click Next. 
5 In the Variables dialog, browse for any HTML Report Template (Excel could be 

used, but for this example HTML is to be used). 
6  Click Finish. 

Choosing the Geometric Items 
As with the previous methods, you must decide which geometric features can be used to determine the alignment. It is best to choose points that create a triangle shape, to lock the part in place. In this example, the part is aligned using a series of probed circles. The centres of these circles are then used to determine the best fit points.  

1 In the Mouse Context toolbar, select the Wireframe Checker  button.  
2 Right-click an empty area of the graphics window and select Surface from the menu. Select the top flat plane as before and create 4 probe points on the surface. 
3 Right-click the CAD View, and select Wireframe from the menu. 
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4 Select the three circles shown, and use the Geometry Explorer to link them to Plane 1. 

 
5 Select the Run tab and simulate the inspection. 

Generating a Best Fit From Points Alignment 
1 In the Sequence Tree, click  to close the group. 

2 From the Alignments  toolbar, select the Best Fit from Points Alignment   
 button. The Best Fit Form Points Alignment dialog is displayed with Point 1/3 selected. 
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3 Select Circle 1: Centre from the drop-down list. The nominal position values of 
the circle are displayed.  
PowerInspect automatically uses the X, Y and Z coordinates for Circle 1::Centre 
because the nominal values have been extracted from the CAD model using 
Geometry Explorer. If you want to load the nominals yourself, deselect 
Automatically use feature nominals, and click Load Nominal>>. 

 By default, PoweINSPECT creates a best fit for all the features in the alignment. If you want the alignment to leave the nominals of the first point unchanged, select the Hard point check box. 
4 Click  to display Point 2/3. 
5 Select Circle 2::Centre and then click Load Nominal. 
6 Click  to display Point 3/3. 
7 Select Circle 3::Centre and then click Load Nominal. 

 A minimum of three points are required for the alignment. You can add 
more points by clicking . 

8 Select OK to create the Best Fit alignment. 
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PowerInspect CNC generates a series of probe paths from the user defined inspection sequence, which can be executed on the calibrated CMM. The probe paths are largely controlled by feature selection, and the order in which individual features are positioned in the Sequence Tree, but it is important to control the position of the probe head and the probe paths outside the selected features. 
We have a variety of features available to allow us to do this within PowerInspect CNC. These features are covered in the following section. 

Default Probe and Parameters 
These parameters control the default distances and speeds associated with the probe movement.   

 
Although the distances specified here are global settings, you can adjust them by 
creating a Probe and Parameters  item from the Miscellaneous  toolbar. 

6. Controlling Machine 
Movements 
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Approach specifies the distance from the selected measure point along the probing vector, to which the probe is moved before the measure move begins (i.e. measure start position).  Given that the physical part may not be in the exact location, or cut to the exact specifications of the part, the probe may not make contact with the part when it is driven to the specified contact location. 
Search specifies the distance from the approach point to an arbitrary point along the probing vector in which the measurement contact point is expected.  
Retract specifies how far the probe will retract from the theoretical contact position 
when the probe is triggered. 
The Goto speed can be output to the CNC CMM to control the speed between 
features in the sequence tree.  Measure speeds should be set to the calibrated probing speed for the probe used on the machine. 
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Approach, Search and Retract distances 
Each measured point in PowerInspect CNC consists of a number of moves to complete the measurement. These are the made up of: 
 Connecting moves between the measured features 
 If safe plane is enabled, connecting moves at the safe plane height to the approach point 
 Approach moves, from the safe height to the target probe point 
 Retract moves from the target point to the safe height. 
The diagram below shows the various moves to measure a feature: 

 
It is important these positions are known, and can be controlled. PowerInspect CNC lets you specify a number of default values, which enable each of the above positions to be calculated. 
The default values can be overridden for each measured item in the Sequence Tree, to give full control of the different features and methods. 
It is also possible to specify three different speeds for the movements which make up a measurement sequence, through the CNC option file, although all three may not be implemented in all CNC option files.  
These are: 
 Connecting move speed 
 Approach speed 
 Measure speed 
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Probe Safe Parameter 
During probe path creation you can specify a position to which the probe will move before and after probing the points of a feature. This can be done by setting the 
Probe Safe distance on the Feature tab. The positions of the moves are calculated relative to the normal of a plane for 2D features, and normal to the initial probing vector for 3D features and surface inspection points. 

 

Safe Plane 
The Probe Safe parameter is used in the SafePlane probing method.  
The Safe Plane is the height above the component to which the probe moves before performing the connecting move to the next inspection point, as shown in the diagram. 

  



PowerInspect CNC 2017 6. Controlling the Machine 

Copyright © Autodesk PowerInspect CNC 2017 6.5 

Collisions 
Collisions can sometimes occur in a probe path and show up in the Sequence Tree 
as a brown star  on the inspection item. 

 

Edit the feature using Edit Geometric Item  button in the Features tab to alter the probe paths so there are no collisions. 
When there are no collisions, a green star  is shown instead. 

 

Intermediate Paths 
Intermediate Paths can be used to avoid collisions between features. 
1 Import the DemoBlock2008(CMM+Arm) CAD file into a new session in PowerInspect CNC. 
2 Create two probed planes as shown below. 

 
3 Select the View > Probe Paths > Show All menu option. 

This shows all the probe paths, including the transition moves between the probed features (shown in grey). No collision is shown in the Sequence Tree, but 
when you simulate the sequence, a collision is detected a warning is displayed. 
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This is where Intermediate Paths can be used to avoid these collisions. 

4 Select the Miscellaneous toolbar and choose Intermediate Paths. 

 
5 Enter a Safe Plane distance of 15. 

 
6 Double click on the CAD model to create two points, one on the top surface and one on the side surface as shown: 
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7  Click 
The linked image cannot be displayed.  The file may have  been mov ed, renamed, or deleted.  Verify that the link  points to the correct  file and location. to save your changes to the Intermediate Path. 

8 In the Sequence Tree, drag the Intermediate Path item between planes 1 and 2. 

 
9 Simulate the probe sequence and it will now run with no collisions.   
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PowerInspect CNC enables you to measure 2D and 3D geometric items either by manually defining the features, from the Item toolbar, or by using the Wireframe Checker and selecting features from the CAD model. Supported items are: 
 2D – Lines, Planes, Circles, Ellipses, Slots and Rectangles.  
 3D - Cylinders, Cones and Spheres. 

 2D items require a reference plane to calculate the projected points. 

Wireframe Checker 
The Wireframe Checker  button enables you to pick features directly from a 
model in the CAD view. Details of the selected feature are automatically displayed in the Feature Inspect and Geometry Explorer tabs.  
The type of feature identified by the Wireframe Checker depends on its selection mode. To change the selection mode, select the Wireframe Checker button; right-click in an empty space in the graphics window in the CAD View; and select an option from the menu: 

 
When you select an item with a probe path from the CAD model, the Feature Inspect 
dialog opens. 

7. CNC Geometric 
Inspection 
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Feature Inspect Dialog 
When you create or edit a feature with a probe path, an Inspect dialog is displayed in the Features tab. This dialog contains information about the feature itself, such as 
the nominal values, and method used to create the probe path. 

 
Different dialogs are displayed for different types of feature, such as Plane Inspect, 
Arc Inspect, and Cone Inspect; all the dialogs contain the following information: 
Name and mode area 

  
This specifies the name of the feature. Select: 

 The Create New Feature  button to create a feature of the same type. 

 The Edit Geometric item  button to edit the selected feature. 
Feature parameters area  
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The parameters displayed in this area depend on the feature being created or edited. They can include X, Y, Z coordinates, start and end angles, and whether the feature is to be probed internally or externally. 
Probing area  

 
Use this area to select the probing method that specifies how the probe path is created. Settings related to the probe path can also be specified or changed. 
Toolbar area 

 
Use the buttons in the toolbar to save or cancel changes and, where applicable, to simulate a probe path and add or remove points from it. 

Using the Features tab 
The first time you add a new type of feature to the inspection sequence, PowerInspect CNC selects a probing method and uses it to create the probe path. If you change the probing method, PowerInspect CNC remembers the changes and applies these parameters to the next similar feature. 
PowerInspect CNC supports several types of probing method. With the exception of a plane, which typically needs to be user defined, geometric items use 
AutoTouchTrigger methods by default. 
To view and change the properties of a probing method, click the Parameters  button. The Parameters dialog is displayed. 
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Geometry Explorer 
The Geometry Explore tab lies next to the Features tab. When you select an item from the CAD model, the nominal data for the item is displayed in the Geometry 
Explorer. 

 

Using the Item Toolbar 
When you create geometric items using the Item toolbar, instead of the Wireframe Checker, the Geometry Explorer tab enables you to specify the item you want to 
measure. 
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Feature Inspection Example 
1 In the Main toolbar, click  to create a new document using the wizard.  
2 Select Measurement with a single CAD part, and click Next. 
3 In the second dialog of the wizard, click New. 
4 In the Open dialog, select Demoblock2008.ddz and click Open. 
5 In the Machine tab, select, or define, a 3 mm probe.  
6 Select the probe in the Sequence Tree’s Default Probe and Parameters item. 

7 Select the Wireframe Checker  button. 
8 Right-click in the CAD and select Surface from the menu. 
9 In the Select View toolbar, select ISO1 and pick the surface shown. 

 
Plane 1 is displayed in the sequence tree. 

10 Select the Features tab. The toolbar’s point counter shows that a minimum of 
three points are required to measure the plane. It is displayed with a red background to indicate you have not yet specified enough points to create the item. 
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11 In the CAD View, the curser changes to a target. Double-click the surface to create three probe points as shown: 

 
The counter increments each time you create a point. When you have specified at least three points, the counter background counter changes to green.  

12 Click  to create the Probed Plane item. 

13 Select Plane 1 in the Sequence Tree, and, select the Edit Geometric item  button in the Features tab. 
14 Double-click the plane surface to add an extra probe point.  
15 Position the mouse cursor over a probe point. When the cursor changes to a hand, left-click and hold the button to drag the point. Reposition the probe points the points as show: 

 

16 Click  to save your changes.  
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17 Click the Simulate Strategy  button to simulate the probe movements in the 
CAD View. 

 You can adjust the simulation speed using the Simulation Parameters area of the Machine tab. 
18 Ensure the Wireframe Checker button is still selected, then right-click in the CAD View and select Wireframe from the menu. 
19 Select the circle shown below. 

 
The Arc Inspect dialog is displayed in the Features tab. 

20 Click the Parameters  button to open the Parameters dialog. 

21 Change the number of Points to 4. Click  to save your changes.  

 
The circle now requires 4 points to be probed. 

22 Click  to save your changes, and click  to simulate the probe path. 
23 Ensure the Wireframe Checker button is still selected, button and select the top edge of the next hole as shown. 
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The probe path settings are remembered from the previous feature. 

24 Click  to create the item, and click  to simulate the probe path. 
25 Right-click in the CAD view, and select Surface in the menu.  
26 Select the cone. The Cone Inspect dialog is displayed in the Features tab. 
27 In the Features tab, click  to open the Parameters dialog. 
28 Change the number of Slices to 2. This reduces the number of points required from twelve to eight.  
29 To avoid the holes in the cone surface, change the vertical distance between the 

points to 20 mm and click . 

 
 
 
 

Another method of avoiding the holes in the surface is to create the probe path using an 
AutoTouchTrigger method, and then switch to the UserDefined method. This enables you to drag the points to a better location on the cone surface. 
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Feature Inspection Example 2 
1 In the same document, hide or delete the previously created features. 

2 In the Item toolbar, click  to create a Geometric group. 

3 In the Features toolbar, select  to create a Probed Circle item. 
4 Select the circle shown: 

 
5 Select the Geometry Explorer tab. 

 
The nominals are listed for the selected feature and any features linked to it.  

6 Select the Arc and select  to create the item.  
 You could have done this for just the plane and only created it. 
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Probe orientation 
Some model requires suitable alignment of the probe to the orientation of the feature being measured. You can do this manually by setting the probe angle in the 
Machine tab or automatically by selecting the Auto-orientation option in the Inspect dialog. 

1 Select the Wireframe Checker  button, and select Wireframe in the menu. 
2 Select the slot edge as shown. 

 
A warning is displayed is displayed in the Features tab: 

 
This warning is displayed if the approach or the retract distance is too great for the measured feature. This can be fixed outside the feature by creating a new Probe and Parameters item, or by editing the active/default Probe and Parameters item. 

3 Click  to create the Slot item. 
 A new plane, Plane 2, is also created because the slot needs a reference plane to identify its orientation. 
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4 Open the Miscellaneous  toolbar and click the Probe and Parameters  
button. 

5 Name the item Slot Parameters and set the Approach and Retract distances  
to 2 mm. 

 
6 Click OK to save your changes and close the dialog. The Slot Parameters item is added to the Sequence Tree. 
7 Drag Slot parameters above Slot 3 in the Sequence Tree. 

 
The brown icon on the slot and its reference plane indicate they have probe path collisions. 

8 Select Slot 3 in the Sequence Tree and then select the Edit Geometric item  button in the Features tab. 

 
The warning referring to approach and retract distances has been addressed but, because the probe remains in the vertical orientation required for the previous feature, a probe path to measure the slot in the side face cannot be created. 
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9 To orient the probe for the slot’s reference plane:  
a Select the plane in the Sequence Tree.  
b Click in the Features tab to edit the feature. 

c Select the Orientation  button to automatically orientate the probe for 
the plane.  

d Click  to save your changes. 
10 Repeat step 9 for the Slot item. 

 
By setting the probe to Auto Orientate, a probe path is successfully calculated. Auto Orientate orientates the part or probe based on the surface normal of the first point in an inspection group, or the overall normal of a geometric item.  

11 Select the Plane item and the Edit Geometric item  button. 
12 Using the left mouse button, move the probe points into a better position as shown 

 

13 Click  to save your changes. 
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Simulating an inspection 
PowerInspect CNC allows you to simulate consecutive features from an inspection sequence. This enables you to identify potential probe collisions during connection moves between features. You can simulate the entire sequence, a specified range of features, or individual features. 
1 At the top of the inspection sequence, select the Run tab, then select the 

Simulate Program tab. 
The list at the top of the tab displays the inspection items in the Sequence Tree: 

 
The buttons in the Simulate Program area are used to control the simulation: 

 
2 Click the Play All  button to simulate the inspection. A warning message is displayed. 

 
This warning is produced as the connecting move between the last point of the probed cone and the first point of the plane results in a collision between the probe and work piece. You can rectify this by inserting an intermediate path between the cone and plane features. 

Intermediate Paths 
When PowerInspect CNC creates probe paths to measure items in the inspection sequence, it automatically creates moves to link these paths. By default, link moves do not appear in the CAD View, but you can display them by selecting the View > 
Probe Paths > Show All menu option; they are shown as light grey lines. 
Automatic links move the probe between features using the shortest route and cannot be changed. Because this may sometimes cause collisions, you can replace these links using Intermediate Probe Path items to control the movements of the probe. 
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1 Select the Sequence Tree tab. 
2 Open the geometric group, and, in the Miscellaneous toolbar, click the 

Intermediate Path  button. 
3 In the Intermediate Path dialog, select the UserDefined – Optimal probing method, 

and type 100 in the Probe Safe box. 

 
4 Create two intermediate points, running away from the cone feature, by double-clicking the left mouse button on the top face positioned as shown. 

 

5 Click  to create the Intermediate Path item. 
6 Move the Intermediate Path item between the Cone and Plane 2. 

  
7 Select the Run tab. 
8 Click  to rewind to the start of the sequence, and then click  to restart the simulation. 
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The probe path simulates without collisions, but leaves the probe in a potentially unsafe position. 

9 Edit the Intermediate Path item, and create two intermediate points, running from the base of the part to the top face positioned as shown. 

 
10 In the Probing method list, select UserDefined – Surface Normal.  

 
11 Click  to open the Parameters dialog. 
12 Select the Orientate Every Point check box. 
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13 Click  to save your changes. 

14 In the Intermediate Path dialog, click  to save your changes, and simulate 
the inspection sequence from the start. 

 To avoid probe collisions at the start of the simulation, you may need to manually reposition the probe. To move the probe in the CAD View, select 
the Manipulate probe  button in the Mouse Context toolbar, left-click the probe and drag it to a suitable location. 
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PowerInspect CNC allows you to compare the physical part against a CAD model by creating and measuring a surface inspection group. This will highlight the accuracy and error deviation outside the defined tolerance of the part. 
The tolerances of inspection groups can be changed globally in the New Document 
Wizard, in the Measures Parameters dialog, or in each inspection group. 

Surface Inspection 
Surface point groups enable you to make free-form inspections of surfaces on a part. Use them when you want to specify the probe path for the inspection. 
To create a surface inspection group: 
1 In the Inspection Groups toolbar, click On-the-fly surface points. 

 
The Surface Inspect dialog is displayed in the Features tab with the default 
Probing method. The cursor changes to a target in the CAD View. 

8. CNC Inspection Groups  
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2 Double-click the model to create points on the top surface as shown: 

 

3 In the Surface Inspect dialog, click  to create the inspection group. 



PowerInspect CNC 2017 8. CNC Inspection Groups 

Copyright © Autodesk PowerInspect CNC 2017 8.3 

A collision icon is displayed in the Sequence Tree. This is due to the move between the upper and lower surface of the part: 

 

4 In the Surface Inspect dialog, click  to edit the group. 
The simplest method of correcting the problem is to change the probing method to SafePlane. This forces the probe path to use the safe height specified by the 
first probe position.  

 
However, when a group contains a large number of points, this can produce a lot of unnecessary movements and so increase the probing cycle time. Instead, we will adjust the part of the path causing the problem. 

5 In the Probing method list, select Optimal. 
6 Right-click the path where the problem occurs and select Split here from the menu. 
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An intermediate point, indicated by a yellow diamond, is on the path mid-way between the probe points.  

 You may need to unshade the part to see this point. 
7 Position the cursor over the point. When the cursor changes to a hand, left-click and drag the point to a safe position where there is no longer a collision. To restrict the movement of the point to one major axis, press the X, Y or Z keys while dragging it. 
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8 In the Surface Inspect dialog, click  to save your changes. 
To insert additional probe points into the group: 
1 Select the group in the Sequence Tree. 

2 In the Surface Inspect dialog, click  to edit the group. 



8. CNC Inspection Groups PowerInspect CNC 2017 

8.6 PowerInspect CNC 2017 Copyright © Autodesk   

3 Right-click on the probe path between the points shown below, and select Insert 
from the menu. 

 
The probe path changes to blue. 

4 Double-click the part to insert a probe point. 

 

5 In the Surface Inspect dialog, click  to save your changes. 
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Raster 
In addition to specifying your own probe path for a surface inspection, you can use the Raster probing method to generate a set of regularly spaced probe points across 
all or part of a surface.  
To create a raster probing pattern for a surface: 

1 In the Mouse Context toolbar, select the Surface Selector  button. 
2 Left-click the surface shown to select it: 

 
3 Right-click and select Group Surfaces from the menu. The Level Manager dialog is displayed. 
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4 In the Level Manager dialog, type a Name for the level, such as Srf1, and click 
OK. A level is created containing the surface, and a colour is assigned to the 
level. 

 

5 In the Inspection Groups toolbar, click  to create an On-the-fly Surface 
Points group. 

6 Double-click the inspection group item in the Sequence Tree to open the 
Inspection Group: Surface Points dialog. 

7 Select the Page 2 tab, and then select the Use custom levels check box. 

 
The CAD Object Selection dialog is displayed. 
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8 Select User Levels, and ensure only the level you created is selected.  

 
9 Click OK to close the dialog and save your changes. 
10 Click OK in the Inspection Group: Surface Points dialog. 
11 In the Surface Inspect dialog, select Raster in the Probing method list: 

 

12 Click  to save your changes. A raster probe path is displayed on the model: 

 
To specify the limits of the raster path: 

1 In the Surface Inspect dialog, click  to edit the group. 
2 Click the Parameters  button. The Raster Parameters dialog is displayed. 
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3 Select Specify limits and click . The Edit Boundary dialog is displayed, and a blue selection area is superimposed on the CAD model. 
 To move the box, position the cursor over a yellow line, and, when the cursor 

changes to , left-click and drag. 
 To change the size of the box, position the cursor over a blue line, and, when 

the cursor changes to , left-click and drag. For example: 
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The positions and sizes of the boundaries are displayed in the Edit Boundary dialog. Any points outside these boundaries are excluded from the probe path.  

4 Click  to save your changes and close the Edit Boundary dialog. 

5 Click  to close the Raster Parameters dialog. 
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Edge Inspection 
Edge points enable you to inspect the boundary of a surface. To measure an edge point you must take a point on the surface near the edge you want to inspect, followed by a point against the edge. 
Guided Edge Points groups enable you to automate the inspection of a surface boundary. Use them to specify the probe path for the inspection. 

1 In the Inspection Groups toolbar, click the Guided Edge Points  button. The 
Edge Inspect dialog is displayed in the Features tab. 
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2 To specify the probe points, double-click on the top surface, close the edge shown in red: 

 
3 When you have created the points for the group, choose an entry in the Probing Method list to specify the order in which the points are to be taken. Select: 

 SurfaceSurfaceProbing to probe all the surface points before probing the corresponding edge points. 

 
 SurfaceEdgeProbing to alternate between probing surface and edge points. 
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 Because the probe path automatically adapts to the position of the surface, you are recommended to check the approach and retract distances for the group and adjust them if necessary. 
4 Run the inspection to obtain data for the part. PowerInspect displays the inspection point with respect to the tolerances 

 
 In this example, the part is in tolerance and close to zero deviation. 
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Section Inspection 
Section groups enable you to measure cross-sections through a part by specifying a plane along which the part must be probed. When you have measured a section group, you can view individual measurements by opening the group in the Sequence Tree, or you can use the Section Group tab below the CAD view to see a graphical representation of the section and the position and deviation of each point relative to the surfaces of the model. 

1 In the Item toolbar, click the Section Group  button. The Section Inspect dialog is displayed in the Features tab. 
2 In the Sequence Tree, double-click the item’s name, The Section dialog is displayed.  

 
3 Select X in the Plane list, and type 100 in the Coordinate box to specify the 

location of the section.  
4 Click OK. A guide line for the section is shown in the CAD View. 
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5 In the Section Inspect dialog, select Raster in the Probing Method list.  

 
PowerInspect creates probe points at regular intervals along the section plane. 

 
6 Click the Parameters  button. The Raster Parameters dialog is displayed.  
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7 Select the Specify limits option and click . The Edit Boundary dialog is displayed, and a blue boundary area is displayed around the CAD model. To restrict the limits of the probe path: 
 position the cursor over a yellow line, and, when the cursor changes to , left-click and drag. 
 position the cursor over a blue line, and, when the cursor changes to , left-click and drag. 
A green line identifies points that are within the boundaries and a pink line identifies those that are outside.  

 

8 Click  to save your changes and close the Edit Boundary dialog. 

9 Click  to close the Raster Parameters dialog. 
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Many features created within PowerInspect CNC can be modified in several ways. Modifications can be made to items, probed points and even PowerInspect CNC itself. 
This chapter briefly goes through the deletion and reordering of points, and some display modifications. 

Accessing Modification 
You can edit or modify items in three ways: 
 Right-click an item in the Sequence Tree and select Modify Item from the menu. 

 

9. Modifying Elements 
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 Select the item and click the Modify  button on the Sequence Tree toolbar. 

 
 Press Alt+Enter on the keyboard. 
When you modify geometric items, the dialog that specifies the item’s parameters is opened. This enables you to change the constraints of the item. For example, in a Geometric PLP Alignment where a line is specified using the centres of two circles, the line can be altered to pass through different features. 
Most modifications work on a similar principle. The next example shows how to delete unwanted results and how to rectify the point numbers to maintain a continuous set of results. 

Modifying an inspection group 
In this example, the DemoBlock2008 part was probed and during the inspection an anomalous point was taken. The anomaly was verified by taking a point at the same position and comparing the results. The deviation of the anomaly is greater than that of the surrounding results, so it will be removed from the group. 
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1 Select the inspection group in the Sequence Tree and click  to open it. 
2 Right click on the anomalous result, in this case SP11, and select Delete in the 

menu. The point is removed from the inspection group. 

 
This leaves a gap in the point numbers, so they need to be reordered. 

3 Click the Up One Level  button.  
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4 Select the inspection group in the Sequence Tree, and click the Modify  button.  The Surface Inspection Group dialog is displayed. 

 
5 To renumber the inspection points, in the Point names area: 

a Enter a Counter value of 1. 
b Enter an Increment value of 1.  
c Select Update existing points. 

6 Click OK. The points names are updated in the Sequence Tree with point SP11 being renamed to SP10 and so on.  
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PowerInspect enables you to use multiple alignments in a single inspection document. Multiple Alignments can be used in a variety of situations: 
 To define a local coordinate system or datum to help in the measurement of features. 
 Having a local datum for geometry on each side of the component.  
 To use a different alignment for each item in the inspection sequence 
 If the original location of the component is changed, it can be realigned without losing the previously measured results. 
 When customer requirements require multiple alignments are used. 

Multiple Alignment Example 
The following inspection outlines how alignments can be used in combination. For this example, the DemoBlock2008 file is used. 
1 Create a Geometric PLP alignment using the top, flat surface as a plane and the two circles indicated, with line between circle 1:centre and circle 2:centre. 

 
2 In the Inspection Groups toolbar, click On-the-fly Surface Points to create a surface inspection group. 
3 Double click over on the surface to create probe points for the inspection group. 

10. Multiple Alignments 
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4 Run the inspection on the measuring device.  

 
The example shows the surface used for the alignment, Plane 1, is within tolerance. However, the other top surface is out-of-tolerance towards the other end of the block. We can attempt to improve the alignment by creating a Best Fit item that includes the results of the inspection group.  

1 Select the Alignments  toolbar, and click the Best Fit  button. The Edit 
BestFit Definition dialog is displayed.  
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2 Select Inspection Group 1 and click . The inspection group is moved to the 

Selected items table. 
3 Click OK to save your changes and close the dialog. 
4 In the Sequence Tree, right-click the BestFit item, and select Play Item from the menu. The Best Fit Analyser dialog is displayed. 



10. Multiple Alignments PowerInspect CNC 2017 

10.4 PowerInspect CNC 2017 Copyright © Autodesk   

 
The graph shows the spread of results for Inspection Group 1 

5 To perform the best fit, click the Go Step button. PowerInspect analyses the deviations of the inspection points and, using the Method allowed by the definition, adjusts the alignment to improve the fit of the points in the inspection group. The graph is updated to show the spread of point measurements after the Best Fit item has adjusted the alignment. 

 
By using the Best Fit, PowerInspect determines the surface profile is correct, and when the calculated translations and rotations are applied, all the measured points are within tolerance.  
From this we can conclude the machining program is correct for the form of the component, but we will need to investigate why the component has deformed from the centre to the lower outer edge, about its X axis. 
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